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20. MS Word 

 

Important Keys 

 

Microsoft word 
Microsoft Word is the most suitable software utilized for building text files. These text files can 

be altered and transferred from the creator to others and edited by them as well. 

It is one of the office productivity applications involved in the Microsoft Office suite. Formerly 

developed by Charles Simonyi and Richard Brodie, software engineers. It was first released in 

1983. Any word file is by default saved with the extension “doc”.  

 

Features of Microsoft Word 
This is how MS Word window looks like (version 2007): 

File 

• It contains options related to the file, like New (used to create a new document), Open 

(used to open an existing document), save (used to save document), save As (used to save 

documents), History, print, share, Export, info, etc. 

Home 

• From the Home menu, the user can copy/ cut the existing text & paste it to some other 

place in the same document or the other document. 

• The other processes that can be operated from the ‘Home ‘menu are changing fronts, 

color, size, case, alignment, spacing. 

• Bullets, numbers, and paragraphs can also be introduced from the same menu. Users can 

look for a particular word in the document by clicking on “Find” form the Home menu or 

simply pressing “Ctrl+F”. There is an option of replacing that word too. 

Insert 

• From the ‘Insert’ menu, files apart from the text can be embedded in the document. E.g. 

screenshots, links & hyperlinks, images, tables, charts, equations, special symbols, shapes, 

headers, footers& page numbers. 

Layout 

• It is the fifth tab present on the menu bar or ribbon. It holds all the options that allow you 

to arrange your Microsoft Word document pages just the way you want them. It includes 

options like set margins, display line numbers, set paragraph indentation, and lines apply 

themes, control page orientation and size, lines breaks, etc. as shown in the below image: 

Design 

• From the Design menu, users can obtain pre-decided templates of fonts & font sizes for 

heading, subheading & other text of the document. 
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• The helps improve the readability of the file quickly. 

• Page layout option provides the user with a chance to change the spacing before the 

paragraphs, indents, and general margin spacing of the page. 

Review 

• The review option helps users check spelling & grammar errors in the document & protect 

the document from being edited by non-trusted users. 

 

Various window elements of MS- word 

1. Title bar 2.Menu Bar 

3. Toolbars 4.Workspace 

5. Status Bar 6.Scroll Bars 

7. Scroll Box 8.Task pane 

• Menu bar: Contains file, Edit, View, Insert, Format, Tools, Table, Window and Help menus. 

• Standard Toolbar: Contains icons for shortcuts to menu commands. 

• Formatting Tool Bar: contains pop-up menus for style, font and font, size; icons for 

boldface, italic, and underline; alignment icons; number and bullet list; indentation icons, 

the border icon, highlight, and font color icons. 

• Ruler: Ruler on which you can set tabs, paragraph alignment, and other formats. 

• Status Bar: Display page number, section number, and total number of pages, pointer 

position on page and time of day. 

• Task pane: Displays and groups commonly used features for convenience. 

 

MS Word Terminologies 

1. Word Wrap: A feature of the word that moves or advances text to the next ine when 

typing exceeds the right margin without pressing the Enter kay. 

2. Drag and Drop: A smart approach to copy or transfer text a short distance. 

3. Word Art: Text designed as a graphic image. 

4. Thesaurus: A feature that provides synonyms or alternative words for chosen words. 

5. Footer: A feature that allows the text/graphics that are marked on every page or segment, 

regularly at the bottom yet can be anywhere on a page. 

6. Header: A feature that allows text/graphics that are imprinted on every page/ section, 

usually at the top yet can be anywhere on a page. 

7. Paragraph styles: A feature that allows text style for complete paragraphs including their 

fonts, alignments, tabs, etc. 

8. Endnotes: Notes or reference that resemble at the end of the document. 

9. Footnotes: Comments or references that appear at the bottom of each page. 

10. Indent: A feature that allows setting a temporary left or right margin for paragraph lines. 

11. The Margin: The gap between the edge of the text in the record and top, base, or side 

edges of the page. 

http://www.totalexam.in/


 
20. MS Word 

 

YouTube Channel: TotalExam                            TotalExam Plus App: Google Play Store 
 

268 

12. Page Break: The spot in a document where one-page ends and the other starts. 

13. Bullets & Numbering: A feature that enables the user to generate bulleted or numbered 

paragraphs. 

14. Landscape: A terminology used to specify page orientation, where the page is wider than 

it is tall. 

15. Page orientation: How pages are laid out in a written document. 

16. Portrait: A page orientation where the page is longer than it is wide. 

17. Formatting Toolbar: A feature that enables changing character and paragraph formatting, 

such as alignment and type styles. 

18. Fort style: Certain regular changes in the appearance of a font. 

Charts: Graphs that employ columns, lines and pie shapes to denote numbers and data. 

 

 

 

 

1. In MS Word 365, Ctrl+E is the keyboard 

shortcut to_______.  

(a) Center aligns the selected text  

(b) Right align the selected text  

(c) Left align the selected text  

(d) Justify the selected text 

2. Which keyboard shortcut is used to close 

a MS Word 365 document?  

(a) Alt+ F4  (b) Ctrl+W  

(c) Alt+X  (d) Alt+S 

3. Which keyboard shortcut is used to insert 

a hyperlink for the selected text in 

Microsoft Word?  

(a) Ctrl + K  (b) Ctrl + H  

(c) Ctrl + F  (d) Ctrl + L 

4. Which option of print setting is used to 

choose only specific pages in MS Word 

365?  

(a) Quick print  (b) Print all pages  

(c) Custom print  (d) Print selection 

5. Which shortcut key is used to open a new 

file in MS-Word 365?  

(a) Ctrl+N  (b) Ctrl+O  

(c) Ctrl+S  (d) Ctrl+P 

6. Which shortcut key is used to save a file in 

MS-Word 365?  

(a) F12  (b) Ctrl+S  

(c) Ctrl+O  (d) Ctrl+N 

7. Which shortcut key is used to display the 

font dialog box in MS-Word 365?  

(a) Ctrl+D  (b) Ctrl+T  

(c) Ctrl+Shift+F  (d) Ctrl+F 

8. Which shortcut key is used to move the 

cursor one word to the left in MS-Word 

365?  

(a) Ctrl+Left arrow key  

(b) Ctrl+Right arrow key  

(c) Ctrl+Up arrow key  

(d) Ctrl+Down arrow key 

9. Which shortcut key is used to switch to 

print preview in MS-Word 365?  

(a) Ctrl+Alt+I  (b) Ctrl+Shift+P  

(c) Ctrl+P  (d) Ctrl+Shift+I 

10. Which shortcut key displays the Editor 

task pane to check spelling and grammar 

in the document or the selected text in 

MS-Word 365?  

(a) Ctrl+E  (b) Ctrl+Shift+E  

(c) F7  (d) Ctrl+F7 

11. Which shortcut key is used to copy the 

selected data in MS-Word 365?  

Booster-1 



 
Computer Awareness MCQs 

 

WhatsApp No. – 888-27-555-63      Website: - www.totalexam.in         

269 

(a) Ctrl+C  (b) Ctrl+X  

(c) Ctrl+V  (d) Ctrl+Z 

12. Which shortcut key is used to add a new 

blank slide to an existing presentation in 

MS-PowerPoint 365?  

(a) Ctrl+N  (b) Ctrl+M  

(c) Ctrl+O  (d) Ctrl+P 

13. Which shortcut key is used to open a new 

file in MS-Word 365?  

(a) Ctrl+N  (b) Ctrl+M  

(c) Ctrl+O  (d) Ctrl+P 

14. Which keyboard shortcut key in MS-Word 

2010 is used to move the previous cell in 

a row of the table?  

(a) Shift+Tab  (b) Shift+Enter  

(c) Shift+Ctrl+Tab  (d) Shift+Ctrl+Enter 

15. Which feature in MS-Word 2010 is used to 

type very letters or numbers smaller than 

the normal line of type and set slightly 

above the line of text?  

(a) Subscript  (b) Superscript  

(c) Strikethrough  (d) Underline 

16. Which keyboard shortcut is used to move 

through each of the open tabs going to 

the right in Chrome browser?  

(a) Ctrl+Tab (b) Ctrl+Shift+Tab  

(c) Alt+Tab                  (d) Alt+Shift+Tab 

17. In MS-Word 2010, the keyboard shortcut 

Ctrl+X is used to _________.  

(a) Copy  (b) Paste  

(c) Cut  (d) Undo 

18. Text editor and text formatters belong to 

which category of computing?  

(a) Operating Systems   

(b) Word Processors  

(c) Browsers   

(d) Database Systems 

19. Which keyboard shortcut is used to center 

align the selected text in MS-Word 2010?  

(a) Ctrl+C  (b) Ctrl+E  

(c) Ctrl+R  (d) Ctrl+L 

20. Which option is not available in the 

'proofing' group of the 'Review' tab in MS-

Word 2010?  

(a) Comment  (b) Thesaurus  

(c) Translate  (d) Language 

21. Which keyboard shortcut is used to save a 

MS-Word 2010 document?  

(a) Ctrl+S  (b) Ctrl+O  

(c) Ctrl+N  (d) Ctrl+P 

22. Which shortcut key is used to align the 

paragraph to the right in MS-Word 2010?  

(a) Ctrl+L  (b) Ctrl+E  

(c) Ctrl+R  (d) Ctrl+J 

23. In MS-Word 2010, which shortcut key is 

used to delete a character to the right 

side?  

(a) Delete  (b) Backspace  

(c) Shift+Delete  (d) Ctrl+Delete 

24. Which key is used to run spell check in 

MS-Word 2010?  

(a) F7  (b) F8  

(c) F9  (d) F10 

25. Instead of retyping the same text in MS-

Word 2010?  

(a) Cut + Paste (b) Copy + Paste  

(c) Paste Special          (d) Delete + Paste 

26. In MS-Word 2010, creating a large capital 

letter used as a decorative element at the 

beginning of a paragraph or section refers 

to ______. 

(a) Large Caps  (b) Font Art  

(c) Drop Cap  (d) Text Art 

27. In MS-Word 2010, if you press the Tab key 

within a table, the cursor moves to the 

next______ of the table-  

(a) Row  (b) Column  

(c) Cell  (d) Page 
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28. Which alignment option will distribute 

your text evenly between the margins in 

MS-Word 2010?  

(a) Justify  (b) Center  

(c) Left Align  (d) Right Align 

29. In MS-Word 2010, which shortcut key is 

used to delete one character to the left 

side?  

(a) Delete  (b) Backspace  

(c) Shift+Delete  (d) Ctrl+Delete 

30. What is the minimum Zoom percentage in 

MS-Word 2010 application?  

(a) 10%  (b) 25%  

(c) 50%  (d) 100% 

31. In MS-Word 2010, _________ Cells means 

that the adjacent cells are thereafter 

treated as a single cell, even though they 

did start as a single cell- 

(a) Split  (b) Merging  

(c) Format  (d) Group 

32. In MS-Word 2010, the ________ is a 

small, customizable toolbar that displays 

frequently used commands like save, 

undo, Redo, etc.  

(a) Taskbar       

(b) Menu Bar  

(c) Ribbon        

(d) Quick Access Toolbar 

33. The distance between the written text 

and the edge of a paper in MS-Word 2010 

is called ______. 

(a) Padding  (b) Border  

(c) Margin  (d) Gutter 

34. Which shortcut key is used to align the 

text to the left in MS-Word 2010?  

(a) Ctrl+L  (b) Ctrl+R  

(c) Ctrl+E  (d) Ctrl+J 

35. Which feature in MS-Word 2010 can be 

used to draw a straight line across the 

selected texts in a document?  

(a) Line Tool     (b) Strikethrough  

(c) Drawing Tool          (d) Shapes 

36. Which shortcut key is used in MS-Word 

2010 to apply double spacing to the 

paragraph?  

(a) Ctrl+2  (b) Ctrl+1.5  

(c) Ctrl+1  (d) Ctrl+5 

37. In paragraph formatting of MS-Word 

2010, Ctrl+ Q is used for which purpose?  

(a) To remove paragraph formatting of 

highlighted paragraph 

(b) To align text to the right 

(c) To insert a new paragraph  

(d) To insert a tabulation 

38. A table in MS-Word 2010 can be unlimited 

rows and a maximum of _________ 

columns.  

(a) 63  (b) 256  

(c) 512  (d) 1024 

39. In MS-Word, the function key F12 is used 

to _______.  

(a) Close the document  

(b) Open the save As dialog box  

(c) Open the print dialog box  

(d) Open the Find dialog box 

40. _______ function in MS-Excel changes 

when a document of MS-Word 2010 is 

already open, which keyboard shortcut is 

used to open a new document?  

(a) Ctrl+O  (b) Ctrl+Z 

(c) Ctrl+S  (d) Ctrl+N 

41. In MS-Word 2010, which shortcut key is 

used to delete one word to the right side?  

(a) Ctrl+Del               

(b) Shift+Delete  

(c) Ctrl+Backspace    
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(d) Ctrl+Right arrow 

42. Which shortcut key is used to apply 

superscript formatting in MS-Word 2010?  

(a) Ctrl + Shift + =      (b) Ctrl + =  

(c) Ctrl + Alt + =        (d) Ctrl + Shift + + 

43. Which keyboard shortcut is used to move 

the cursor up one paragraph in MS-Word 

2010?  

(a) Ctrl + Up arrow key  

(b) Ctrl + Down arrow key  

(c) Ctrl + Left arrow key  

(d) Ctrl + Right arrow key 

44. Which keyboard shortcut key is 

equivalent to CTRL + S to save an open file 

in MS-Word 2010?  

(a) F12                         (b) Shift + F12  

(c) Ctrl + F12               (d) Ctrl + Shift + S 

45. Which command is used in MS-Word 

2010 to open the file page to use 

backstage view?  

(a) Alt+F  (b) Alt+O  

(c) Alt+B  (d) Alt+V 

46. Which shortcut key is used to increase the 

font size to the next larger point size 

available in the font size list box of MS-

Word 2010?  

(a) Ctrl+Shift+>  (b) Ctrl+Shift+<  

(c) Ctrl+>  (d) Ctrl+< 

47. Which feature in MS-Word 2010 is used to 

type very letters or numbers smaller than 

the normal line of type and set slightly 

above the line of text?  

(a) Subscript  (b) Superscript  

(c) Strikethrough  (d) Underline 

48. In MS-Word 2010, the keyboard shortcut 

ctrl +X is used to _______.  

(a) Copy  (b) Paste  

(c) Cut  (d) Undo 

49. The arrangement of data in rows and 

columns in MS-Word 2010 is called a 

________.  

(a) Table  (b) Worksheet  

(c) Spreadsheet  (d) Database 

50. Which keyboard shortcut key in MS-Word 

2010 is used to change the paragraph 

spacing to 1.5-line spacing?  

(a) Ctrl+1.5  (b) Ctrl+2  

(c) Ctrl+1  (d) Ctrl+5 

51. What is the minimum number of rows a 

table can have in MS-Word?  

(a) 1  (b) 2  

(c) 3  (d) -1 

52. In MS Word 2007, which option under 

print preview is used to switch the page 

layout between portrait and landscape?  

(a) Orientation  (b) Size  

(c) Margin  (d) Page Layout 

53. To compare two versions of an MS Word 

2010 document, one has to go to the 

_______ tab and click _______ under the 

‘Compare’ group-  

(a) Review, compare   

(b) View, Compare  

(c) File, compare   

(d) Home, Compare 

54. ______ is a large capital letter used in MS 

Word 2010 as a decorative element at the 

beginning of a paragraph or section-  

(a) Decorative Cap  (b) Initial Cap  

(c) Capital Letter  (d) Drop Cap 

55. _______ provide a neat way to present 

complex information in vertical columns 

and horizontal rows of cells in Microsoft 

Word-  

(a) Tables  (b) Lists  

(c) Graphs  (d) Charts 
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56. Working in a MS Word text document. It 

selects the entire paragraph by default 

when the mouse is clicked- 

(a) Single Click  (b) Double Click  

(c) Triple Click  (d) Right Click 

57. Mail-merge is a component of- 

(a) MS-Word  (b) MS-Excel  

(c) MS-PowerPoint  (d) MS-Outlook 

58. Using the end key in Microsoft word 

processor moves the cursor to the end of 

the ________.  

(a) Page  (b) Line  

(c) Document  (d) Paragraph 

59. In the context of a word document, the 

word ‘gutter’ is used for?  

(a) Space left in one side for sewing and 

binding 

(b) Space left in between two columns 

(c) Space left in between two pages  

(d) Space left in one side of the book for 

binding 

60. Using the ‘Home key’ in Microsoft word, 

processor moves the cursor to the 

beginning of the- 

(a) Page  (b) Line  

(c) Document  (d) Paragraph 

61. On which menu bar is the spelling tool 

located?  

(a) Review  (b) Tools  

(c) Edit  (d) Format 

62. In the new version of Microsoft Word, the 

document is saved with _______ 

extension by default?  

(a) .doc  (b) .docx  

(c) .txt  (d) .rtf 

63. Actions are given by default to the word 

document-  

(a) Open  (b) .DOC  

(c) Print  (d) Close 

64. .bas, .doc and .html is an example of- 

(a) Extension  (b) Protocol   

(c) Language  (d) Format   

65. Which is a Customizable bar that comes 

with a set of independent commands and 

gives you an easy reach to commonly used 

commands, such as save, Undo, Redo, etc. 

(a) Ribbon    

(b) Taskbar   

(c) Quick Access Toolbar  

(d) Status Bar   

66. Callisto MT, Arial, and Century are 

different types of _______. 

(a) Typeface  (b) Font   

(c) Script  (d) Text   

67. In MS Word, if you press the Tab key 

within a table, the cursor moves you to 

the ………... 

(a) Next Column     (b) Next Cell   

(c) Next Row           (d) Previous Cell   

68. The feature that fills up forms etc. 

automatically with preset values is called- 

(a) AutoComplete  (b) AutoFill   

(c) AutoForm  (d) FormFill   

69. In an MS Word 2019 document, an email 

address appearing in a text is shown as a 

hyperlink. To convert the email address 

into regular text, right click on the address 

followed by- 

(a) Edit Hyperlink   

(b) Removing Hyperlink   

(c) Copy Hyperlink   

(d) Open Hyperlink   

70. What is the second largest font size that 

can Be selected using the ‘Font Size’ drop-

down list in MS-Word 2016? 

(a) 48  (b) 72   

(c) 96  (d) 36   



 
Computer Awareness MCQs 

 

WhatsApp No. – 888-27-555-63      Website: - www.totalexam.in         

273 

71. What will be the default number of cells 

in a Microsoft word table with two rows 

and three columns? 

(a) 2   (b) 3   

(c) 6  (d) 8   

72. The maximum number of columns that 

can Be inserted in MS Word 2019 through 

insert tables operation is- 

(a) 32  (b) 63   

(c) 50  (d) 100   

73. Which tool in MS Word copies the entire 

format and style of the selected text? 

(a) Format Painter  (b) Style Copier   

(c) Format Copy  (d) Text Painter   

74. Which tab in the menu bar of Microsoft 

Word 2007 provides the facility of 

proofing, commenting, making changes, 

and comparing them in MS Word 

documents? 

(a) Home  (b) Insert   

(c) Review  (d) View   

75. Which is best suitable to create, edit and 

save professional documents like letters 

and reports? 

(a) Excel  (b) PowerPoint   

(c) MS Word  (d) OneNote   

76. Which method is used to insert Clip Art in  

       MS Word? 

(a) Insert Object Command   

(b) Insert Picture Command   

(c) Insert Image Command   

(d) Insert Graphic Command   

77. Which type of section break helps to start 

a new section on the same page in 

Microsoft Word? 

(a) Page Break         (b) Column Break   

(c) Continuous        (d) Next Page   

78. What is another name for MS Word? 

(a) Text Editor        

(b) Word Processor   

(c) Text Processor    

(d) Document Writer   

79. Which command removes personal 

information added to a file in Microsoft 

Word? 

(a) Inspect Document   

(b) Remove Personal Info   

(c) Check for Issues   

(d) Document Inspector   

80. How will MS Word respond in case a word 

is immediately repeated? 

(a) A blue wavy line under the repeated 

word 

(b) A red wavy line under the repeated 

word   

(c) A green wavy line under the repeated 

word   

(d) No response   

81. To change selected text to All Capital 

Letters, you have to click the change case 

button and then- 

(a) Capitalize Each Word  

(b) Uppercase   

(c) Lowercase    

(d) Title Case   

82. In MS Word, which option under “Change 

Case” is used to convert the selected text 

from upper case to lower case and vice 

versa. 

(a) Sentence Case  (b) Lowercase   

(c) Uppercase  (d) Toggle Case   

83. What is the font size limit in Microsoft 

Word 2007? 

(a) 1 to 72  (b) 1 to 1638   

(c) 1 to 1000  (d) 1 to 1024   

84. In Microsoft Word 2013, which menu 

Includes table row height to change the 

height of the row? 

(a) Insert  (b) Layout   

(c) Design  (d) Format   

http://www.totalexam.in/


 
20. MS Word 

 

YouTube Channel: TotalExam                            TotalExam Plus App: Google Play Store 
 

274 

85. In Microsoft Word, the document 

orientation is set_____ by default- 

(a) Landscape  (b) Portrait   

(c) Square  (d) Vertical   

86. Microsoft Word is an example of- 

(a) System Software   

(b) Utility Software   

(c) Application Software   

(d) Firmware   

87. The default Zoom level in Word is set at- 

(a) 75%  (b) 90%   

(c) 100%  (d) 150%   

88. In the RUN command dialog box, ______ 

command will start the Microsoft Word 

application program? 

(a) msword.exe         (b) word.exe   

(c) winword.exe       (d) startword.exe   

89. MS Word is basically used for- 

(a) Data Analysis   

(b) Preparing various documents   

(c) Presentations   

(d) Database Management   

90. Which component of MS Office is 

categorically similar to Notepad? 

(a) Excel  (b) Access   

(c) MS Word  (d) Publisher   

91. In MS-Word, ‘’Ctrl+W’’ is used to- 

(a) Close the current document   

(b) Close the current window   

(c) Save the document   

(d) Open a new document   

92. Which shortcut key is used to find a 

particular word in a Word document? 

(a) CTRL+H  (b) CTRL+F   

(c) CTRL+G  (d) CTRL+K   

93. To move to the bottom of a document, 

press_______. 

(a) Page Down  (b) End   

(c) Ctrl + End  (d) Alt + End  

94. Which is the default body font in 

Microsoft Word 2007? 

(a) Times New Roman   

(b) Arial   

(c) Calibri   

(d) Verdana   

95. You can start Microsoft Word using the 

______ button- 

(a) Office  (b) Start   

(c) Program  (d) Launch   

96. The minimum and maximum font sizes 

available in the font size tool available in 

the Formatting toolbar is- 

(a) 8 and 72  (b) 6 and 72   

(c) 8 and 100  (d) 1 and 1638   

97. In which view menu of MS Word do 

headers and footers appear? 

(a) Normal View   

(b) Web Layout View   

(c) Print Layout View   

(d) Outline View   

98. Page fault occurs when- 

(a) Page is not present in memory   

(b) Page is not in the cache   

(c) Page is corrupted   

(d) Page is duplicated   

99. How many times can the Undo/Redo 

feature be used in MS Word 2007? 

(a) 20  (b) 50   

(c) 100  (d) Unlimited   

100. Forward and Backward icons appear for 

scrolling through pages in MS Word’s 

………. View- 

(a) Print Layout  (b) Read Mode   

(c) Web Layout  (d) Outline   

101. The default name of the file created with 

MS Word 2010 is- 

(a) Document           (b) Document 1   

(c) Untitled               (d) New Document   
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102. Which Key(s) can be used to select 

Multiple words, lines, or paragraphs in 

MS Word- 

(a) Shift  (b) Ctrl   

(c) Alt  (d) Tab   

103. What is the maximum font size used for a 

character? 

(a) 72  (b) 128   

(c) 1638  (d) 1000   

104. Concatenation of text can be done by 

Using- 

(a) Plus, Sign (+)  (b) Comma (,)   

(c) Ampersand    (d) Hash (#)   

105. What is Arial- 

(a) A text styles   

(b) A paragraph styles   

(c) A font in Microsoft Word   

(d) A theme in Microsoft Word   

106. In the context of MS Word-2019, the 

keystroke “Ctrl+Shift+F5” is related to- 

(a) Insert Citation   

(b) Insert Cross-reference   

(c) Bookmark   

(d) Insert Table of Figures   

107. Which tab will you choose to insert a 

watermark in the document in MS Office 

Word 2016? 

(a) Page Layout  (b) Insert   

(c) Design  (d) View   

108. Which tab in Microsoft Office 365 Word 

is used to change the color of the 

document content area? 

(a) Home  (b) Insert   

(c) Layout  (d) Design   

109. _______ can be used for quick access to 

commonly used commands and tools? 

(a) Status Bar  

(b) Quick Access Toolbar   

(c) Taskbar   

(d) Ribbon   

110. Which feature of Word enables a person 

to send the same letter to different 

people? 

(a) Mail Merge (b) Form Letter   

(c) Data Merge (d) Multiple Mail   

111. Graphics for Word Processor- 

(a) Clip Art  (b) Shapes   

(c) Pictures  (d) SmartArt   

112. Which option is not available in the file 

menu while working with MS Word? 

(a) Open        

(b) Save   

(c) Header and Footer       

(d) Print   

113. If both left and right sides of a paragraph 

Are aligned, then it is called- 

(a) Justified  (b) Left Aligned   

(c) Right Aligned  (d) Centered   

114. To insert a watermark in a document in 

MS Office- Word 2016, which would you 

choose? 

(a) Page Layout  (b) Design   

(c) Insert  (d) References   

115. MS Word document has decorative text 

in- 

(a) Clip Art  (b) SmartArt   

(c) Charts  (d) WordArt   

116. In MS Word 365, which menu contains 

the ‘Re-use Files’ option- 

(a) Insert  (b) Review   

(c) Home  (d) References   

117. What is the maximum zoom percentage 

in MS Word? 

(a) 200%  (b) 400%   

(c) 500%  (d) 1000%   

118. In an MS Word document, to set 

predefined formatting on text, to apply 

color, etc. _____ can be used- 

(a) Themes  (b) Styles   

(c) Templates  (d) Designs   
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119. In MS Word, which option splits a cell in 

a table into multiple cells? 

(a) Divide Cell         (b) Split Cell   

(c) Merge Cell         (d) Subdivide Cell   

120. To make the formatting of even numbers 

different from that of odd columns, 

which option is used in Word? 

(a) Banded Rows   

(b) Highlight Even Rows   

(c) Banded Column   

(d) Different Columns   

121. To make a capital letter at the beginning 

of a paragraph, use- 

(a) WordArt  (b) Drop Cap   

(c) Text Box  (d) Capitalize   

122. In MS Word 2016, the button to make the 

selected text bold can be found in the 

tab- 

(a) Insert  (b) Layout   

(c) Home  (d) Design   

123. Bullets and numbering command is 

present in which menu? 

(a) Format  (b) Insert   

(c) View  (d) Home 

124. Consider the following statements 

regarding line spacing of a paragraph in 

MS Word 2010? 

A. Line spacing determines the amount 

of vertical space between lines of the 

text in a paragraph 

B. Line spacing determine the amount 

of diagonal space between lines of 

text in a paragraph 

Which of the following statements is 

correct?    

(a) Both A and B (b) only B 

(c) Neither A nor B (d) only A 

125. Which of the following buttons are 

present in the Quick Access Toolbar by 

default in MS Word 2010?  

(a) Save, Undo, Redo  

(b) Undo, Redo, Cut 

(c) Undo, Redo, Name 

(d) Paste, Redo, Copy 

126. Shading option in MS Word 365 is used 

for_______. 

(a) Changing the color of the selected 

text 

(b) Changing the color behind the 

selected text 

(c) Making the text pop by highlighting it 

(d) Changing the color around the 

selected text 

127. Which of the following statement about 

Quick Access Toolbar in MS Word 2010 

is/ are incorrect? 

P. The Quick Access Toolbar Has Save, 

Undo and Redo buttons by default 

Q. The Quick Access Toolbar Has Cut, 

Undo and Redo buttons by default 

R. You can place more buttons on the 

quick access toolbar  

S. There is no option on quick access 

toolbar for ‘’show below the Ribbon’’  

(a) Only q and R (b) All P, Q, R, S  

(c) Only Q and S (d) Only P, Q, R 

128. Which of the following font effects is not 

available in the MS Word 2010 font 

dialogue box? 

(a) Double strike through  

(b) Superscript 

(c) Small cap     

(d) Equalize character height 

129. Which of the following is not a valid file 

format in MS Word 365? 

(a) .dotx (b). dcp 
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(c) .doc (d) .docx 

130. Which of the following is not a type of a 

paragraph formatting in MS Word 365? 

(a) Right (b) Precise 

(c) Justify (d) centre 

131. Which of the following is not a valid file 

format in MS- PowerPoint 365? 

(a) .pptm (b). pwpt 

(c) .ppt (d) .pptx 

132. Which of the following effects is not 

available in the MS-Word 2010 font 

dialog box? 

(a) Italic (b) Bold 

(c) Subsript (d) Fancy 

133. Which of the following is not a word 

processor? 

(a) Microsoft word  

(b) Chrome 

(c) Notepad            

(d) LibreOffice Writer 

134. Which of the following is not an option of 

menu bar in MS Word 2007? 

(a) Insert (b) Home 

(c) Internet (d) Page Layout 

135. Which of the following features are 

available in Microsoft? 

I. Check the document for spelling 

and grammar errors 

II. Add header, footer and page 

number 

III. Protect the word document with 

password 

(a) l and lll only (b) ll and lll only 

(c) l and ll only (d) l, ll and lll 

136. What does macro mean in the context of 

Microsoft Word? 

(a) Macro is a command used to 

automatically send e-mail 

(b) Macro command automatically 

creates multiple documents with 

similar content. 

(c) A macro is a series of commands and 

instructions that you put together as 

a single command to automatically 

accomplish a task 

(d) Macro command helps in creating 

multiple mails with different 

contents. 

137. In Microsoft Word 2007, which of the 

following is not a valid line spacing option 

in the ‘’paragraph’’ dialog box? 

(a) Single (b) 1.5 lines 

(c) Double (d) Triple 

138. Which of the following option is not 

available in the “paragraph Dialog” box 

of a word processor? 

(a) Line Spacing (b) Numbering 

(c) Indentation (d) Margin 

139. Which of the following is included in a 

paragraph formatting in a word 

processor? 

(a) Subscript           (b) Underline color 

(c) Fonts                      (d) Line spacing 

140. Which of the following cannot be 

inserted using the ‘Insert Menu ‘in MS 

Word? 

(a) Table                 (b) Line Spacing 

(c) Shapes                  (d) Header 

141. Which of the following is/ are examples 

of word processors? 

(a) Microsoft word 

(b) Word perfect 

(c) Both Microsoft Word and Word 

perfect 

(d) None of these 

142. Which of the following is not a necessary 

component to perform a mail merge 

operation? 
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(a) Data source  

(b) Word Fields 

(c) Merge Fields  

(d) Main document 

143. Microsoft word is a part of which of the 

following? 

(a) Microsoft Office  

(b) Microsoft Access 

(c) Microsoft publisher  

(d) Microsoft Windows 

144. Which of the following is not a Document 

view? 

(a) Normal view   

(b) Work view 

(c) print Layout view   

(d) web Layout 

145. In MS Word  

(a) Graphs can be made 

(b) The data can be analyzed. 

(c) Page numbering can be done.  

(d) None of the above 

146. Which of the following is not a style? 

(a) Bold (b) Italic 

(c) Regular (d) Super Script 

147. Which of the following option is not a 

valid menu item in Microsoft Word 2016? 

(a) Insert (b) Home 

(c) Review (d) Tools  

148. Which of the following is not a casing 

change feature in MS Word? 

(a) Un- capitalize each word  

(b) Capitalize each word 

(c) Toggle case   

(d) Sentence case 

149. State whether the following statements 

are true or false with respect to MS 

Word? 

I. In Landscape orientation, the height 

of a page is greater than its width. 

II. In portrait orientation, the width of 

a page is greater then its height. 

(a) (l) False (ll) True  

(b) (l) True (ll) True 

(c) (l) True (ll) False  

(d) (l) False (ll) False 

150. With respect to Microsoft word 

documents, which of the following 

statement is False?  

(a) Footers help users to repeat content 

at the bottom of every page. 

(b) Headers help users to repeat content 

at the top of every page. 

(c) Page numbers can appear either at 

the top or the bottom of every page 

(d) A single document cannot have both 

Roman and Arabic numerals as page 

numbers. 

151. Which of the following is not a character 

formatting option in Microsoft word? 

(a) Effects (b) Underline 

(c) Indentation (d) Font style 

152. Which of the following statements is 

incorrect regarding paragraph 

indentation in Microsoft word? 

(a) Left indentation can be set as a 

positive value. 

(b) Left indentation can be set as a 

negative value. 

(c) The right indentation can be set as a 

negative value. 

(d) Right indentation can be set as a 

positive value. 

153. Which of the following commands does 

not affect the next font? 

(a) Underline (b) Italic 

(c) Border (d) Bold 

154. Which of the following statements is 

correct regarding Microsoft word? 
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(a) Every document must have at least 

one table. 

(b) A document cannot contain both 

bulleted and numbered lists. 

(c) Different paragraph of the document 

may have different alignments.  

(d) There cannot be more than one drop 

cap in the document. 

155. Which of the following statements 

regarding Microsoft word is incorrect? 

(a) There can be only one sentence in a  

paragraph 

(b) A document can contain multiple  

tables. 

(c) Every document must have a drop  

cap 

(d) A document can be renamed 

multiple  

times. 

156. Which of the following is/are function of 

MS word software? 

I. Creating, editing, saving, and 

printing documents 

II. Copying, pasting, moving and 

deleting text within a document 

III. Creating and editing tables 

(a) l, ll and lll (b) lll only 

(c) ll only (d) l only 

157. Which of the following is not in-built 

feature of MS Word? 

(a) Live Stream (b) Spell Check 

(c) Thesaurus (d) Translate 

158. Which of the following is not a basic text 

formatting feature? 

(a) Italic (b) Underline 

(c) Capitalize (d) Bold 

159. Which of the following statement is 

incorrect? 

I. All cells in a table should have the 

same background color in Microsoft 

word. 

II. In Microsoft word, a table can be 

inserted inside another table. 

(a) Only (ll)  

(b) Both (l) and (ll) 

(c) Only (l)           

 (d) Neither (l) nor (ll) 
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Answer Key 

1 A 11 A 21 A 31 B 41 A 

2 B 12 B 22 C 32 D 42 A 

3 A 13 A 23 A 33 C 43 A 

4 C 14 A 24 A 34 A 44 B 

5 A 15 B 25 B 35 B 45 A 

6 B 16 A 26 C 36 A 46 A 

7 A 17 C 27 C 37 A 47 B 

8 A 18 B 28 A 38 A 48 C 

9 A 19 B 29 B 39 B 49 A 

10 C  20 A  30 A  40 D  50 B  

 

 

51 A 61 A 71 C 81 B 91 A 

52 A 62 B 72 B 82 D 92 B 

53 A 63 A 73 A 83 B 93 C 

54 D 64 A 74 C 84 B 94 C 

55 A 65 C 75 C 85 B 95 B 

56 C 66 B 76 B 86 C 96 A 

57 A 67 B 77 C 87 C 97 C 

58 B 68 A 78 B 88 C 98 A 

59 A 69 B 79 A 89 B 99 C 

60 B  70 A  80 A  90 C 100 B  

 

 

101 B 111 A 121 B 131 B 141 C 

102 A 112 C 122 C 132 D 142 B 

103 C 113 A 123 D 133 B 143 A 

104 C 114 B 124 D 134 C 144 B 

105 C 115 D 125 A 135 D 145 C 

106 C 116 A 126 B 136 C 146 D 

107 C 117 C 127 C 137 D 147 D 

108 D 118 B 128 D 138 D 148 A 

109 B 119 B 129 B 139 D 149 C 

110 A  120 C  130 B  140 B  150 D  

 

Booster-1 



 
Computer Awareness MCQs 

 

WhatsApp No. – 888-27-555-63      Website: - www.totalexam.in         

281 

 

151 C 

152 C 

153 C 

154 C 

155 C 

156 A 

157 A 

158 C 

159 C  
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